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Thayer demystifies Word/Excel

M
arsha Thayer, our MVPCUG secretary,
will demonstrate the workings of Word and
Excel, demonstrating a variety of practical
tips and tricks. She will be using the 2000

version of the programs, but most of the information
should apply to all versions, as well as suggesting ways to
apply her techniques to other word processors and
spreadsheets. If time permits, Marsha will also show us
how to use PowerPoint.

As usual, Marsha will be taking questions. If you would like to

have her address a specific issue, please send an email to her with

your question by November 30 at mvpcug@usadatanet.net.

     T     T     T     T

As winter will soon be upon us, we run the risk of cancellation of our
monthly meeting if the school closes. School closings are usually listed on the
radio in the morning and a notice will also be put on our web home page
(www.mvpcug.com). 

Note that whether our SIG meetings are 
held is at the discretion of the SIG leader. 

Please phone or email  
your SIG leader
regarding closings.

Meeting Agenda

5:30 . . . . . . Meet and Greet

6:00 . . . . Business Meeting

6:30 . . . . . . Program, Part 1

7:00 . . . . . . . . . . . . . . Break

7:15 . . . . . . Program, Part 2

8:15 . . . Drawing for Prizes

8:30 . . . . . . . . Adjournment

ANNUAL
FOOD and TOY

DRIVE
Bring non-perishable
food and/or a new toy to
the December meeting.
You will help the less
f o r t u n a t e  o f  o u r
community while gaining
an extra ticket for the
door prize drawing.

Our Meetings
are open to
the public.

È

No admission
charge!



Stay connected . . . to the MVPCUG
Mohawk Valley PC User Group, Inc.
$25 for initial sign-up  - $20 for renewal

Name___________________________

Address_________________________

City__________________________NY

Zip________Phone________________

E-mail__________________________

Please m ail w ith a check payable to M VPCUG to

MVPCUG
PO Box 586

Marcy NY 13403-0586

GET A FREE MVPCUG MEMBERSHIP

� It’s easy to do and you’ll save $20.00!

� Just sign up two new members and you
receive a one-year membership
extension.

� You have 90 days in which to sign up your
two new members.

Page 2 MVPCUG Explorer | 2003 

The MVPCUG EXPLORER is published

monthly by the Mohawk Valley Personal

Computer User Group, Inc., PO Box 586,

Marcy NY 1403-0586.

Opinions expressed herein are the writers

and are not reflective of the MVPCUG, nor are

they considered substantiated by inclusion in

this newsletter.  All articles are copyrighted by

their respective authors but may be reprinted

by other User Groups provided credit is given

to the author and this publication.

The Mohawk Valley PC User Group, Inc.

(MVPCUG) was founded in 1981 by individuals

interested in IBM compatible computers.  This

non-profit  organization consists of volunteers

whose expertise range from novice to

professional.

Regular meetings are held on the first

Tuesday of the month at 6pm, usually at the

Whitesboro High School, Route 291, Marcy

NY. A typical agenda consists of discussion of

business affairs and a demonstration of

computer related products.  Meetings are open

to the public.

Initial membership fee for an individual is

$25. Annual renewal dues are $20.

ADVERTISING RATES

¼  page — $25   e   ½  page — $45

NEWSLETTER STAFF
Editor

Bob Schaffer

Columnists

Jerry Finkelstein
Donna Gorrell
John Hunter
Joe Madeira

The Explorer is printed by

The Gallery
4780 Commercial Drive - New Hartford

315-768-7851

Our INTERNET presence is at

http://www.mvpcug.com

The Web Team

Dan Evans
Lisa Britt

HELP HOTLINES
Help is limited to times indicated below. Day calls:

9am to 4pm. Evening calls: 6 to 9pm. If your problem
isn’t urgent, please try e-mail.

Disclaimer: The individuals listed here provide
voluntary services and information. Please be
considerate when you call.  Help hotline members
reserve the right to limit the amount of advice and
number of calls they will accept. Use these services
and information at your own discretion and risk as
they and the MVPCUG do not assume responsibility
for any software or hardware failures that may occur.
The club does not assume responsibility for any
agreements made by participating parties.

AOL
. . . . . . . . . . . . . . . . . . . . . . . . . . Dave Askew

 
Basic
. . . . . . . . . . . . . . . . . . . . . . . . . . . Mike Smith

Batch Files
. . . . . . . . . . . . . . . . . . . . . . . . . . Mike Smith 
. . . . . . . . . . . . . . . . . . . . . . . . Tim Clinehens 

 
dBase
. . . . . . . . . . . . . . . . . . . . . . . . . . Mike Smith 

Excel
. . . . . . . . . . . . . . . . . . . . . . . . . . . .  Bob May

 
Money
. . . . . . . . . . . . . . . . . . . . . . . . . Bob Schaffer 

 
Troubleshooting
. . . . . . . . . . . . . . . . . . . . . . . . Tim Clinehens 
. . . . . . . . . . . . . . . . . . . . . . . . . . . Bill Gorrell 

WordPerfect
. . . . . . . . . . . . . . . . . . . . . . . . . Bob Schaffer 

 

OFFICERS AND DIRECTORS

President
. . . . . . . . . . . . . . . . . . . . . . . Jerry Finkelstein

 
Vice President
. . . . . . . . . . . . . . . . . . . . . . . . . . . Bill Gorrell

 
Treasurer
. . . . . . . . . . . . . . . . . . . . . . . . Donna Gorrell

 
Secretary
. . . . . . . . . . . . . . . . . . . . . . . . Marsha Thayer

 

Directors-at-Large
. . . . . . . . . . . . . . . . . . . . Tim Clinehens [‘04]

. . . . . . . . . . . . . . . . . . . . . . Dave Askew [‘05]

. . . . . . . . . . . . . . . . . . . George Bracken [‘06]

Special Interest Groups (SIGs)
Our Special Interest Groups usually meet
each month. Each SIG is independent and

has its own leader.

Internet SIG — 3rd Mon at St. John's
Episcopal Church, 135 Main St., Whitesboro,
at 6:30pm. Learn about web pages and how
to navigate the Internet. Jerry Finkelstein

Q&A SIG — Last Mon at St. John's
Episcopal Church, 135 Main St., Whitesboro,
at 6:30pm. Questions, whether simple or
complex. Tim Clinehens.

Basic Training SIG — Last Wed at St.
John's Episcopal Church, 135 Main St.,
Whitesboro, at 6:30pm. Learn Basic
operations, like turning the machine on and
off. Lisa Britt

WordProcessing SIG — doesn’t meet
monthly, but you can request weekly emails
with tips for both WordPerfect and Word from
Bob Schaffer

Genealogy Club —3rd Tuesday at
Calvary United Methodist Church, 706 North
Madison Street in Rome.
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Minutes, Meeting of Tuesday, November 4, 2003 
The MVPCUG general meeting was held at the Whitesboro
High School. President Jerry Finkelstein called the meeting
to order at 6:05 p.m.  
Business Meeting

Members present approved the minutes of the October
general meeting.

Treasurer’s report: Income for the period of
10/1/2003-10/31/2003 was $227.43; expenses for the
period were $273.22; the balance in the treasury as of
10/31/2003 was $4658.01.  The treasurer’s report was
accepted to be included with the minutes.

Jerry reminded that beverages (coffee, tea, hot
chocolate) are $0.25 per cup.

Donna reported that the Newsletter is on-line and
available in HTML and PDF. Inputs for the Newsletter are
due by the 1st of each month. Stu Culp asked if we should
consider sending the Newsletter to members via PDF e-mail
attachment rather than mailing a hard copy. Bill Gorrell
mentioned that some people don’t have e-mail. The Board
continues to discuss the best way/ways to get the
Newsletter to the club membership. We did see a show of
hands from those who NEEDED to have a hard copy
mailed to them. It was a minority of those present.

Tim made a presentation on the upcoming Open Box
SIG. The purpose is to help people to upgrade their system,
not fix it. The types of upgrades that would be appropriate
for the SIG are add/replace a hard drive; replace a video
card, sound card or modem; add a network card, add USB
2.0, etc. Participants in the SIG will be determined by
Lottery. Interested members sign up and get a blue ticket.
Tim will send e-mail to those who signed up within 12
hours. They need to respond within 48 hours. Before
bringing a computer to the SIG for upgrade, do a full
backup, note where all the plugs are and bring only the
Tower/Desktop. Three people will be chosen from the
Lottery. The SIG will begin on the 3rd Thursday in January
at 6 pm and will be held at A-Z Auto on Oriskany Blvd.

Bill and Donna announced that we have a NYS Tax ID
for paying sales tax associated with selling club CDs.

Presentation:  At 6:40, our presenter, Laurie Wrona,
from Microsoft was introduced. Laurie presented us a
sneak preview of the Microsoft Office System containing
Office 2003. The Microsoft Office System includes Info
Path, Publisher, Visio, Project, Front Page, and Office.

Highlights of the tool changes are:

Word 
has a new reading layout view with column and

magnification options.
has a new ‘Research’ tool which provides a panel of

research places and has search capability
has on-line templates in several categories

Excel
a task pane is also available
has several templates for everyday uses such as garage

sales, loan calculators, etc. All templates can be customized
for personal use.

Document recovery - can merge the saved crash
document with the latest saved document. Choices are
available on how to manage this.
PowerPoint

can attach audio and video
can package PowerPoint multimedia presentations to a

CD. A PowerPoint viewer gets packaged with the
presentation so those recipients of the CD can view it and
not need the PowerPoint application. 
Outlook

Outlook supports e-mail, calendars and scheduling.
may have several e-mail accounts (users) in Outlook
the reading pane is larger and can be moved around
contains a SPAM manager that allows users to identify

which e-mail is good and which to direct to the junk e-mail
folder. Users can identify a safe-sender list and can also
block e-mail from a sender or senders.

has a feature to allow sending digital photos in small,
medium and large formats
Break - We took a break at 7:25 and resumed at 7:40.
Presentation (cont’d)  
Publisher

added design sets which are intended to give a uniform
look and feel to a person’s or company’s web pages,
letterhead, business cards, e-mail, etc.

had many selections for greeting cards
OneNote

This new tool provides support for notetaking.
Has support for notebooks and palm PCs
Can attach sound to record lectures.
Has speech recognition.
Will convert handwriting to text.

At 8:12 we concluded the presentation.
Dave Askew reported that 23 toys were collected for

Toys for Tots and 138 food items were collected for the
Utica/Rome Food Bank.

Tom Maggio reported that the Genealogy Club meets on
the 3rd Tuesday of each month at Calvary United Method-
ist Church on 706 North Madison Street in Rome. �

[Door Prizes listed on page 7.]

Minutes of October 7, 2003

– Marsha Thayer, Secretary



Word Processing Tips
— by Bob Schaffer 

Page 4 MVPCUG Explorer | December 2003

Remember when CDs first came on the scene? They
were touted as being the best thing since sliced bread.
They were supposed to last forever or at least a century
or two. Floppy disks and Zip disks were a thing of the
past so dump all your old equipment, transfer everything
to CD and your data will be safe forever.  Maybe not.

Some computers no longer come with an “A” drive,
and I’ll bet there are only a few who remember those
5.25" black, really floppy things that fit into B drive. Is
there a computer around that still has a “B” drive?

The latest news is that CDs are not ever-lasting. If you
have put your data onto a CD and think it will remain
viable for years to come, think again. Did you attach a
fancy label? Not a good thing as the glue may turn your
data into mush. Do you have printer that prints directly to
CDs, well, that ink also is suspect to degrading. 
Apparently you can write on the CDs with a felt tip pen,
but even that could cause trouble. Merely burning your
own CDs means that the data may or may not last. The
best thing to do is check your CDs frequently to make
sure they are still OK. 

Read more about this at: www.informationweek.com/
story/showArticle.jhtml?articleID=15800263.

Speaking of CDs—backup your important files to a
CD, but check that CD often to make sure the files are
still readable. Better yet, send the CD to a family member
or friend so the CD is out of your house in case of disas-
ter. Never know when a tree might fall on your house.
You can also send zipped up files to someone and have
them store the info on their computer. If you don’t know
how to condense a file using Winzip or some other
program, ask one of our gurus. �

MVPCUG PROPOSED BUDGET—2004

Income:
Dues (150 members @ $20) . . . . . . . . . . . . . . $3000
Bank interest . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Advertising . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
Sale of CDs . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
Amount necessary from treasury to balance . . . . 775

Total Income . . . . . . . . . . . . . . . . . . . . . . . $4000

Expenses:
Newsletter . . . . . . . . . . . . . . . . . . . . . . . . . . . . $2000
Postage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 430
Church donation . . . . . . . . . . . . . . . . . . . . . . . . 500
Insurance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 400
Equipment maintenance . . . . . . . . . . . . . . . . . . . 150
Door Prizes . . . . . . . . . . . . . . . . . . . . . . . . . . . . 400
ISP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

Total Expenses . . . . . . . . . . . . . . . . . . . . . . $4000

Windows XP has a defragger built in just like
previous versions. If you delete and add files you
should defrag the hard drive occasionally, which will
help your system run faster and more efficiently. You
can do this while you are sleeping or watching TV.
The defragger is not as graphical as previous versions,
however.

Here’s how to start it:
1. Click START
2. Select All Programs, then Accessories
3. Select System Tools, then click Disk Defragmenter
4. Click the “Analyze” button near the bottom to see a
graphical representation of the hard disk and get a
report. It will probably say that you don’t need to
defragment this volume. However, if you haven’t done
it in quite a while, or you see a lot of red, you should
go ahead and click the “Defragment” button. �

WORD —Cleaning Out Program Toolbars 

Are there toolbar buttons that you never use? Is
your toolbar full? Do you need room for a new toolbar
button or macro that you regularly use? Here’s a
shortcut way to remove a toolbar button and give you
space on your toolbar without going to a two-line
toolbar or having buttons not immediately visible on
the screen.

Simply hold down the Alt key while you use the
mouse to drag an unwanted button away from the
toolbar.

WORDPERFECT —Appending text to Clipboard

If you need to copy several items from a document
to paste into another file, there’s no need to copy and
paste repeatedly. You can copy and append text to the
Clipboard, instead of replacing what’s already there.
Then, you only need to paste once into your target
document.

To append text to the Clipboard contents, select the
first block of text you need to copy and select Copy
from the Edit menu or press [Ctrl]C. 

Then, select the next block of text and choose
Append from the Edit menu. Append all the text you
need, then simply paste it into the destination
document as you normally would. �

 Donna’s Data
— by Donna Gorrell  

Windows XP Tip-of-the-Month
— by Joe Madeira  

http://www.informationweek.com/story/showArticle.jhtml?articleID=15800263.
http://www.informationweek.com/story/showArticle.jhtml?articleID=15800263.
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. . . that you can listen to the tracks of an audio CD in
any sequence you want—even repeat favorite tracks?

1. On the Start menu, go to Programs, then
Accessories, point to Entertainment, and then
click CD Player.

2. Insert the audio CD.
3. On the Disc menu, click Edit Playlist.
4. Click Reset.
5. Click each track desired from the list of

Available Tracks, and then click Add.
6. Click the play arrow.

. . . that you can print part of a page when browsing
the Internet? Here’s how: 

1. Select the part of the page you want to print.
2. On the File menu, click Print.
3. Click Selected

. . . that Internet Explorer allows you to print Links or
Frames? Here are some ways to print a Web page: 

1. Open the Web page you want to print, click the
File menu, and then click Print. If you want to
print only one frame in the page, click inside
that frame before you click Print.

2. If the Web page uses frames, choose how you
want frames to be printed in the Print frames
area. For example, if you want your printed
page to look exactly as it does on the screen,
select As laid out on the screen .

3. If you want to print all pages that are linked to
this page, select Print all linked documents.
Option not available if you chose to print all
frames As laid out.

4. If you want to print a table of all links contained
on this page, select Print table of links. Option
not available if you chose to print all frames As
laid out.

To quickly print just one frame, right-click inside the
frame, then click Print.

. . . that you can rearrange and resize toolbars when
you need more space in the Internet Explorer win-
dow? You can move your toolbar, Links bar, and
Address bar to create more room or to customize your
toolbar for efficiency’s sake. For example, try putting
your Address bar and Links bar on the same line. Or
drag your toolbar up to the menu bar. You can even

put all of the toolbars on the same line if you want.
Here’s how:

1. Point to the vertical bar on the left side of the
toolbar you want to move.

2. When the pointer changes to a double-headed
arrow, drag the toolbar to where you want it.
You can move it left, right, up, or down. 

. . . that if you come across a picture or background
that you like, you can save it and use it as wallpaper
on your computer? Right-click the picture or
background you want; then click Set as Wallpaper.

. . . that if you are tired of waiting for a Web site to
load you can stop it? Simply press the Esc key or
click the red X on your browser’s toolbar. This stops
a Web site from loading.

. . . that you can change the start page of your
browser? Here’s how to do it:

Internet Explorer:
1. Select Tools and then, Internet Options.
2. On the General Tab, click the Use Blank

Button and OK.
Netscape:
1. Select Edit and then Preferences/Navigator.
2. Under Navigator Starts With, select Blank

Page and OK.

. . . that Aladdin offers a 40% discount on products
to user groups? From now on, MVPCUG members
will get Aladdin products at 40% off retail. You
don’t have to enter a code to enter the store. Shop at
Aladdin’s online store —www.aladdinsys.com/store
—and enter the discount code “UserGroup” (exactly
as shown) in the “discount code” field. A 40% dis-
count will be given when you hit “apply”. It’s that
simple! If additional promotions are happening at the
time you are shopping, you will also get those dis-
counts! Tax, shipping, and handling will be added
when applicable. To order by fax, print out the pdf
form at www.aladdinsys.com/support/usergroups 

Here are some of the top-selling PC products:
! Internet Cleanup 3.0. — Block Pop-Ups and

Remove Spyware. $17.99.
! StuffIt Deluxe® 8.0. — Compress files to a

fraction of original size. $23.99.
! Easy Uninstall 2.0. Helps you safely remove

unwanted programs and files. Use Complete
Undo to reverse your changes. $17.99. �

http://www.aladdinsys.com/store
http://www.aladdinsys.com/support/usergroups
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As you read this, we will be mired in shopping; shopping
for husbands, wives, children, grandchildren, nieces, neph-
ews, aunts and uncles, ad nauseam. But since commerce
constitutes a significant portion of our time right now, start-
ing the column with several rather cute shopping oriented
websites is appropriate.

For those familiar with Martha’s Vineyard, the black
dog logo has come to represent the island as well as the
original restaurant. To see a cute, highly graphic,
interactive website that will sell you things as well as keep
your children entertained, try
www.blackdog.net/holiday.html. Click on this URL and
you find a child friendly “Blackdog Loves Holidays!” web-
page. According to the site, this webpage is designed to
introduce children to the Internet “in a safe, concerned
environment.” Blinking at you will be a list of holidays
beginning with New Years, Valentine’s Day, St. Patrick’s
Day and so forth. You may also vote for your favorite
holiday and view the opinions of others (47% of all
respondents picked Christmas). Each holiday provides lots
of activities for kids to use such as making holiday specific
cards and banners.  

Click on an icon for a specific holiday (i.e., Chanukah)
and you will find a list of Chanukah games, activities, free
stuff, Chanukah screensavers, a link to other Chanukah
sites and a link to the Blackdog catalogue (surprise). At the
Blackdog general store you can click to find kid toys, kid
books, kid DVDs, kid software, baby stuff and so on, all
picturing the blackdog logo. And, there is a link directly to
Amazon.com for parents who don’t find anything that
interests them in the Blackdog store. How convenient. 

Another site to check out is www.ideabox.com.  Donna
Gorrell recommends this site and found it in the
CNYPCUG newsletter. However, when I used Google to
link to the site, up popped a screen which read ideabox.com
coming with two pictures of penguins on an iceberg with a
statement that said, “In the world of managing desktop
costs, it’s not what you see . . . It’s what you don’t see”—
and nothing more. Try this site again.

OK. On to another topic. The VA and the Library of
Congress report that 1,800 World War ll veterans die each
day. That we owe a debt to the men and women who fought
for freedom sixty years ago, is not an issue. What is
important is that young people today understand what
happened during WW ll and appreciate the sacrifices these
individuals made so long ago. A number of high schools
nationwide have started oral history projects that acquaint
students with the struggles endured by WW ll combatants.  

Locally, Rome Free Academy conducts interviews with
veterans as part of a 12th grade social studies class and
connects the results to a national effort sponsored by the
Library of Congress. [To date] “… this is the only national
oral history project that is approached as an educational
one,” said Ellen McCulloch-Lovell, director of the Library
of Congress project in an Education Week story on the oral
history project.

Many students now interview World War ll veterans,
Korean War, Viet Nam War veterans and Desert Storm
veterans to find out just what these individuals experienced. 
High school students conduct these interviews using digital
video cameras or tape recorders. These interviews make the
World War ll experience real for today's kids.

 “Before, I didn’t know much about World War ll. 
These veterans make it real,” said 17- year old Randy
Stark, a summer student participating in the Pennsylvania
Governor’s School of Information Technology as quoted in
the story. 

So far, about 8,000 veterans have submitted oral
histories that include 26,000 photographs, letters, and other
memorabilia. A sample of these histories is now available
at www.loc.gov/folklife/vets according to Education Week.  

We hear a lot today about nation building. The World
War ll experience is nation building and civic participation
at the most basic level. Phi Delta Kappan, the journal of the
Phi Delta Kappa educational organization, recently
discussed civic education and political participation. For
those of you interested in teaching citizens about
democracy, what follows is a short list of two websites you
can visit to see how complex this issue becomes.  

WWW.closeup.org is a site that helps high school,
middle school, and elementary school students learn about
government. The site also provides programs for teachers
and senior citizens. The purpose of this organization is the
belief that, “textbooks and lectures alone are not enough to
help students learn the democratic process and make it
work.” According to the Close Up Foundation, “all
individuals deserve the opportunity to become fully engaged
citizens of our democracy.”

This site focuses on the United States, but the lessons
presented here can be used anywhere in the world. Another
site is www.civnet.org. CIVNET is an online resource and
service for civic education teachers, scholars, policymakers,
civic-minded journalists and non-governmental
organizations promoting civic education all over the world.  

According to the website, “…[a] fully functioning
democracy requires a political culture composed of active
participants who understand what it means to be democratic
citizens.” It might prove helpful if President Bush’s
advisors took a look at the site to appreciate the magnitude
of the task facing them in Iraq. Until next month . . . �

  Sites to Visit on the ‘Net
– by John Hunter  

http://www.blackdog.net/holiday.html
http://www.ideabox.com
http://www.loc.gov/folklife/vets 
http://WWW.closeup.org
http://www.civnet.org
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This is the merry time of the year. By the time you
read this you’ve already stuffed yourself with Thanks-
giving turkey. You’re feeling real full and warm and
generous. So you do your Christmas shopping early.
You are looking ahead to happy holidays and a swell
New Year. Mind if the Club joins you in your good
cheer? What we’ve got in store is sure to keep you
looking at the bright side.

Have you noticed our newsletter is now online?
Donna gave us a look at it at our last general meeting.
And what a wonderful newsletter it is. Compare the
last few issues with those of months . . .  years . . .
past. We’ve come a long way. 

Thanks to Bob Schaffer and Donna Gorrell for
taking us there. Still, it’s a work in progress.

Progressing right along is Tim Clinehens’ Open
Box Pilot/Workshop/SIG, depending on response.
Update your PC at George’s AtoZ Auto on Oriskany
Blvd. There’s limited seating, so sign up early. Thanks
to George for letting the Club use his premises for
what will certainly be a very valuable hands-on PC
experience. Another example of members helping
members.

We are working on establishing small workshops
throughout the year. We’re talking to Donna (and will
be talking to others) for startup workshops on
graphics and digital photography. Note that both the
‘Net and Basic SIGs won’t be held in December. 
These two SIGs are being considered for overhaul.
They may have new leaders and/or reappear as series
of workshops, conferences, get-togethers with differ-
ent leaders guiding the groups. Your Board of Direc-
tors welcomes your thoughts on the subject of topics
for SIGs and workshops and to the reconfiguration of
objectives for the ‘Net and Basic groups. Your con-
tributions will be taken quite seriously. 

Tim advises us that he will continue with his Q & A
SIG; that group will now meet on the last Monday of
the month. Our Board meetings have recently taken
up these issues of SIGs and workshops; you’re
welcome to listen in on and contribute to these
discussions. The Board meets at the church on the
second Tuesday of the month.  

And let us look forward to a larger Club member-
ship. We’d be doing great if each member brought in

one friend or acquaintance once a month to join the
Club. Think of the practical benefits: great discounts
to tickets at PC shows; great chances at door prizes;
terrific speakers at our general meetings; individual-
ized attention at SIG meetings; and, as always, mem-
bers helping members with their PC needs. 

There’s more: Bob’s helpful online word process-
ing hints; our Website; and the new streamlined news-
letter in your mailbox and now online. And the com-
radery of meeting up with other men and women with
common PC interests. Bring in a new member; see
how your merry mood gets even cheerier. �

  Byting Remarks
– Jerry Finkelstein   

Door Prizes

[The following prizes furnished by Microsoft]

w Office 2003 - Joe Madeira, Rod St. Clair, 
    Don Pianka, and Loralee Whitlock
w Publisher - Brenda Kopp
w FrontPage - Howard Netzband
w Visio - Jim Schmandt
w OneNote - Mary Tollerton
w MP3 Player - Tony Ciancio
w T-shirts - various members

[The following prize donated by a member]

w scanner - Ed Mohr �



                    what’s.com/ing December 2003                    

Sunday Monday Tuesday Wednesday Thursday Friday Saturday

   1 2
Monthly

General Meeting
6:00 PM

3 4 5 6    Peter Trapp
Computer Show
Syr Fairgrounds

10-4

   7 8 9     Board of
Director’s Mtg

St. John’s
6:30 PM

10 11 12 13

   14  Tri-State
Computer Show
Hudson Valley CC

10-3:30

15
Internet SIG
CANCELED

16 17 18 19 20

   21 22 23 24 25 26 27

   28 29 30
Q & A SIG
St. John’s
6:30 PM

31 Basic Training
SIG

CANCELED HAPPY HOLIDAYS !

Marsha Thayer Demystifies Word and Excel
Tuesday w December 2, 2003 w 6:00 PM w Whitesboro High School


